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 Introduction

Digimarc digital watermark (formerly known as Digimarc Barcode) is a technology for product packaging that 
enables encoding a Global Trade Identification Number (GTIN) or other product code imperceptibly into a 
package’s artwork prior to printing.

For a product, the GTIN carried by a digital watermark is the same as a traditional 1D UPC/EAN barcode. Because 
the digital watermark can be applied to all faces of a product’s packaging, a package enhanced with a Digimarc 
digital watermark supports higher efficiency at retail checkout, increased consumer engagement, more accurate 
inventory tracking, better supply chain management, and other benefits.

The Digimarc Verify application enables you to scan a print sample or import a press-ready digital image file of a 
package and verify that the print sample or image meets the following conditions:

1 The GTIN information carried by the Digimarc digital watermark matches the GTIN information carried by 
the package’s traditional product code.

2 Only one GTIN is present in the package’s artwork.

3 Robustness of the digital watermark is sufficient for the intended use case.

Caution
It's critical that conditions (1) and (2) are met before plates are produced or a package goes to press for 
production printing.

If either condition isn't met, the package carries two (or more) distinct GTINs. If such a package is printed and 
placed on retail shelves, the wrong amount could be charged for a product, or two different products could be 
charged in one transaction. This could disrupt supply chains, inventory tracking, and so on.

This situation can arise if a plate or separation containing common artwork is used in two or more packages. If 
more than one package uses the same plate or separation containing a Digimarc digital watermark, it will result in 
conflicts with other digital watermarks and traditional product codes. If the plate or separation doesn't contain a 
digital watermark, it might be replacing a plate or separation that does, which would reduce the robustness
(strength) of the digital watermark in the printed package and compromise the effectiveness of the watermark.

Warning
Never reuse plates or separations from other jobs when printing packages enhanced with a Digimarc 
digital watermark.

Who Uses Digimarc Verify?
The primary Verify users are:

A printer verifying a print sample as a final check before printing a package at volume

You scan a packaging print sample on a validated   Epson Perfection v39 flatbed scanner and use Verify to 
inspect the scanned image for Digimarc digital watermarks and traditional product codes. (See Validating Your 
Scanner for more information.) Verify compares the GTIN information from any detected digital watermarks to 
each other and to the traditional product code.

• If conditions (1) and (2) are met, printing can proceed.
• If either condition isn't met, don't print the package until you determine the cause of the problem. Contact

Digimarc for help.

https://epson.com/For-Home/Scanners/Photo-Scanners/Epson-Perfection-V39-Scanner/p/B11B232201
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A prepress operator verifying a press-ready digital image file as a final check before delivering the file for 
plate production

You import a press-ready digital image file of your package and use Verify to inspect the image for Digimarc 
digital watermarks and traditional product codes. Verify compares the GTIN information from any detected digital 
watermarks to each other and to the traditional product code.

• If conditions (1) and (2) are met, you can deliver the file for plate production.
• If either condition isn't met, don't deliver the file for plate production until you have identified and corrected

the problem. If you can't identify the problem, contact Digimarc for help.

Supported Media Formats
Digimarc Verify accepts the following digital image file formats. We recommend files be 300 DPI or greater and 
100% in size.

• PSD
• AI
• PDF
• BMP
• PNG
• TIF/TIFF

System Requirements
Digimarc Verify requires:

• 64-bit, 2 GHz or faster processor
• 64-bit Microsoft Windows 10 or 11
• 8 GB or more of RAM
• Epson Perfection v39 flatbed scanner*
• An active internet connection **

Warning
Don't install Verify on a case-sensitive file system or on a removable flash storage device.

* Required only if you scan print samples for verification. See Who Uses Digimarc Verify?

** Required for full functionality.

https://epson.com/For-Home/Scanners/Photo-Scanners/Epson-Perfection-V39-Scanner/p/B11B232201
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Document Conventions
Following are the standards and conventions used in this documentation. See the Glossary for terms related to 
digital watermarking.

Convention Description

Numeric format* The fractional part of a numeric value is represented by the period character, 
such as pi =~ 3.14

Measurements* Measurements are shown in inches, abbreviated to "in," such as 
Dimensions: 5.66 x 4.68 in

Clickable elements in the 
user interface

Formatting: Text in bold

Titles of sections, panels, 
and dialogs

Formatting: Text in italics

Text that a user types Formatting: Text in a monospace font

File and directory paths Formatting: Text in a monospace font

Variables or variable data Formatting: Text in italics, often within angle brackets (< >)

* The Digimarc Verify application adapts to your operating system's regional conventions.
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 Install Digimarc Verify

You can get the Verify application from Digimarc's website at  https://my.digimarc.com.

1 Log into  My.Digimarc. If you don't have credentials, contact your Digimarc account representative.

2 In the Downloads module, click Access Site.

3 Click Download for the desired operating system. The DigimarcVerifySetup zip file is saved to your 
default downloads folder.

4 Extract the contents of the zip file to a temporary folder and run the installer, following the prompts.

Warning
Don't install Verify on a case-sensitive file system or on a removable flash storage device.

When you run Verify, you're asked to sign in or proceed as a guest. See Getting Started with Digimarc Verify.

Validating Your Scanner
This section is for those who plan to scan print samples for verification. If you're importing digital artwork files, skip 
this procedure.

We support only the   Epson Perfection v39 flatbed scanner. See System Requirements.

Before verifying any print samples of packages, validate your scanner to ensure accurate results. The Digimarc 
Verify installer places a shortcut named scanner_validation_file.pdf on your desktop. This shortcut links to 
an image file with which you can validate your scanner.

1 Print the file on a calibrated proofing system at 100%.

2 Add the artwork to your project. 
• On a valid scanner, Digimarc Verify detects one traditional product code and one mismatched

Digimarc digital watermark. The message "A possible GTIN conflict was found" is displayed during
the pre-verify step.

• Any other result indicates an invalid scanner.

3 Follow steps 4-6 in Verify the Artwork. The result of the verification is Fail: Inconsistent barcodes were 
found on the package.

https://my.digimarc.com
https://my.digimarc.com
https://epson.com/For-Home/Scanners/Photo-Scanners/Epson-Perfection-V39-Scanner/p/B11B232201
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 Getting Started with Digimarc Verify

When you open Verify, a blank artboard is shown.

1 Menu: The menu is where you sign in and out, manage projects and artwork, set the color profile, and 
more.

• File
- Manage Region Templates: Opens a dialog where you can manage region templates.
- Exit: Closes Verify without signing you out.

• Preferences
- Default CMYK ICC Profile: Opens the Default CMYK ICC Profile dialog where you can set a

default ICC profile.
- Advanced Detection: This option is intended for use by Digimarc or under Digimarc's

direction. Enabling it could slow the verification process.
- Use Smaller Font: If the fonts in Verify are too big for your screen and resolution, select this

option to use a smaller font size. To revert to the default application font size, deselect it.
• Projects

- Create Project: Projects contain artwork to be verified. If you don't create a project before
adding the art file or scanning the print sample, Verify automatically creates a project for
you.

- Manage Projects: Opens the Manage Projects dialog where you can open a project or
delete one or more projects.

- Add Artwork from File: Enables you to import a press-ready digital image file.
- Add Artwork from Scan: Enables you to scan print samples. See Validating Your

Scanner for more information.
• Sign-in

- Sign In: If you're not signed in, opens the Sign In dialog.
- Sign Out: If you're signed in, signs you out of the application.
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• Help
- Documentation: Opens this documentation in HTML format.
- Legal Notices: Displays the Verify end user license agreement and third-party software

license information.
- Supplemental Features: Enables you to enter an activation code to enable extra features.

To learn more about the supplemental features, contact Digimarc.
- About: Displays the About Verify dialog.

2 Project Tab: Displays tools and information related to the project.
• Toolbar: These icons enable you to add or remove artwork from a project or run a report.

- Add artwork from file: Enables you to import a press-ready digital art file.
- Add artwork from scan: Enables you to scan a print-ready sample. See Validating Your

Scanner for more information.
- Remove selected artwork from project: Removes the artwork from the project without

deleting any associated files.
- Create enhancement report: After you Run Verify, enables you to generate enhancement

reports.
• Run Verify: Starts the verification process. Results are shown in the Results panel.
• Project Metadata:

- Project Name - The name of the project.
- Account Name - The name of the account the project belongs to. We recommend you use

the account name that was used to create the Digimarc digital watermark in the Packaging
module on My.Digimarc.

- Project ID - The alphanumeric identifier for the project.
• Use Case Analysis: This option group enables you to select the scanning environments the

package might be used in. See Select the Use Case Analysis for instructions.
- Point of Sale: For red-light check-out (barcode) scanners in storefronts. See Point of Sale for

details.
- Mobile Phone: For users who scan the product package with Digimarc Discover or other

mobile apps that incorporate the Digimarc Mobile SDK. See Mobile Consumer
Engagement for details.

- Manufacturing: For scanners used in manufacturing and supply chain environments.
See Manufacturing for details.

- Robot: For inventory tracking robots or other kinds of robotic scanners. See Robot
Monitoring for details.

- Recycling: For scanners connected to recycling sortation machines. See Recycling
Sortation for details.

Note
Recycling Sortation is a Supplemental Feature and must be enabled before it 
becomes visible and selectable.

• Artwork Summary: Displays a thumbnail image of each artwork in the project with its filename.
• Color Channels: Displays all the color channels detected in the artwork.
• Icons: Below the Color Channels are three icons:

- Green Digimarc icon: Indicates the color channels that were enhanced.
- Grayscale wheel: Opens the grayscale color separations folder.
- Color wheel: Opens the Spot Color Identification dialog.
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3 Artboard Toolbar: These icons enable you to set substrate opacity and geometry parameters for the main 
artboard. For more information about these options, see Select the Substrate.

• Magnet: Toggles the snap-to behavior for regions. See Select Regions.
• Artwork Substrate & Opacity: Enables you to specify whether the package substrate is opaque or

clear with ink. It applies to the entire artwork for CMYK images only. It's disabled for RGB images.
See Select the Substrate

- Opaque: Enable to indicate the substrate is opaque, such as paper, cardboard, metal, and
so on. This is the default setting.

- Clear Poly with Ink: Enable to indicate the substrate is clear polyethylene with ink providing
all color in the packaging.

• Geometry: Enables you to specify whether the currently selected region is flat or cylindrical.
See Select the Geometry.

- Flat: The region is intended for a flat package section.
- Cylindrical: The region is intended for a cylinder, such as a can.

• Orientation: Selects whether the label will be wrapped around the cylinder horizontally ( ) or
vertically ( ). This applies only to cylindrical regions and is disabled for flat regions. See Select
the Orientation.

• Label Wrap: Selects the percentage of the package the artwork covers. This applies only to
cylindrical regions and is disabled for flat regions. See Select the Label Wrap Percentage.

4 Artboard Tabs: The Regions and Maps tabs show you the regions that you've identified and the validation 
maps that Verify generates.

• The Regions tab contains the artboard (canvas) that displays the artwork and any regions you've
defined.

• The Maps tab shows the validation map for the analyzed package. This tab is empty until you Run
Verify. A table at the bottom of the tab shows the different coverage or consistency maps. The color
coding corresponds to the coverage score.

5 Details Tabs: The Region Details and Results tabs show the details for each region you've identified and 
the results of the verification operation.

• Region Details: Displays the properties selected for each region, including its size, location, and
geometric parameters.

• Results: Displays the validation results from the analysis and more detailed region information, such
as the coverage area and coverage score for the selected Use Case Analysis. These results show
how well the embedded Digimarc digital watermark will operate for each Use Case Analysis. No
results are displayed until you Run Verify.

6 User Status: A green user icon (   ) shows you're signed into Verify. A gray icon (   ) means you're 
using the application as a guest. 

Sign In and Out
Some features of Verify require you to sign in. If you use the application as a guest, those features are 
disabled. You're automatically signed out after 28 days of inactivity.

To sign in:

1 Click Sign-in > Sign In from the menu or click the gray user icon (   ) in the upper right corner of the 
screen. The Sign In dialog opens.

2 Enter your email address and password. If you don't already have an account at My.Digimarc, contact us
to get started.

3 Click SIGN IN. Successful sign-in displays a green and white user icon (   ).
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To sign out:

Click Sign-in > Sign Out from the menu or click the green user icon (   ) in the upper right corner of the screen. 

After you sign out, the user icon turns gray (   ). You can sign in again, another user can sign in, or you can 
use Digimarc Verify as a guest.

If you exit Verify without signing out, you're still signed in the next time you run Verify. 
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 Verify the Artwork

The verification process ensures the enhanced artwork contains the correct digital watermark for the package 
being printed. For information about the application user interface, see Getting Started with Digimarc Verify.

1 Sign in.

2 Click + NEW PROJECT to create a project. To work with an existing project, see Manage Projects for 
instructions on opening a project. 

Note
Artwork must be in a project. If you skip this step, Digimarc Verify creates a project for you.

3 Add the enhanced artwork. See Add Artwork to a Project for instructions.

4 Select regions of the package. See Select Regions for instructions.

5 Enable the desired use case analyses for the verification. See Select the Use Case Analysis for 
instructions.

Tip
To get coverage area, coverage score, and coverage maps, enable Point of Sale, Mobile 
Phone, or Recycling.

6 After all images and regions for a package have been added as desired, click RUN VERIFY . When 
verification is done, the Results tab shows whether validation has succeeded or failed. See Understanding 
Results and Report Details for more information.

Add Artwork to a Project
Each project can have one or more pieces of artwork. Some projects have different artwork for the body of the 
product package and the lid. 

You have two options for adding artwork to a project:

• scan a print-ready sample
• import a press-ready digital art file

To scan a print-ready sample:

Digimarc Verify supports the   Epson Perfection v39 flatbed scanner. Use these steps to verify the scanner 
validation file or scanned artwork.

1 Prepare the print sample. See Preparing the Print Sample for instructions.

2 Connect the scanner and ensure it's turned on. 

3 Click Add Artwork from Scan (   ). 

4 Select the scanner to use. 

5 Click Scan.

6 To add more images for the same package, repeat these steps.

https://epson.com/For-Home/Scanners/Photo-Scanners/Epson-Perfection-V39-Scanner/p/B11B232201
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To import a press-ready digital art file:

1 Click Add Artwork from File (   ).

2 Navigate to the file to use. We recommend files be 300 DPI and 100% in size. See Supported Media 
Formats for more information.

Note
You can import an RGB image file that was created from a previously scanned print sample. In 
this case, the image is treated the same as a scanned sample.

3 Click Open. Verify detects embedded ICC profiles for art files. If you import a file without an embedded 
ICC profile, the software prompts you to import an ICC profile or use the default profile for analysis. 
Verify also automatically runs a pre-verify scan during the import process. If it finds problems, it displays a 
warning. 

The Verify application analyzes selected spot colors to simulate how devices such as red-light scanners 
and mobile phones detect Digimarc digital watermark coverage. For more information about this analysis, 
see Spot Color and Technical Inks.

4 To add more images for the same package, repeat these steps.

Preparing the Print Sample
If you're scanning print samples to verify, each package must be scanned completely, one at a time. Before 
launching Digimarc Verify and scanning, we recommend you prepare the print sample.

• If two (or more) packages share a single print sample (below left), cut the sheet so that each package is on
a separate sheet (below right).

• If a print sample with a single package is too large to fit on the scanner bed (below left), cut the sheet into
smaller pieces that fit completely on the scanner bed (below right). You scan the smaller sheets separately,
but the application enables you to verify the individually scanned sheets as a single package.
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Note
Be sure to leave the 1D barcode intact when cutting print samples.

Set the ICC Profile
Digimarc Verify ships with GRACoL2006_Coated1v2 as the default ICC profile. If you import artwork that has no 
ICC profile embedded, such as an Adobe Illustrator (.ai) or PDF file, Verify offers to use the default profile or a 
profile you import.

• To use the default ICC profile, click Continue.
• To use a different profile, click Import, navigate to the ICC profile file you want to use, and click Open.
• To cancel the import operation, click Cancel.
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The ICC profile file name that was used for each imported image is shown in the artwork toolbar. 

Note
Artwork that has already been imported is unaffected by a change in the default ICC profile. To apply a 
different ICC profile to the artwork, remove the file and import it again with the desired profile.

To set a different ICC profile as the default:

1 Select Preferences > Default CMYK ICC Profile from the menu. The Default CMYK ICC Profile dialog 
opens.

2 Click Select New ICC Profile.

3 Navigate to the desired ICC profile file on your computer and click Open.

To reset GRACoL2006_Coated1v2 as the default ICC profile:

1 Select Preferences > Default CMYK ICC Profile from the menu. The Default CMYK ICC Profile dialog 
opens.

2 Click Reset.

Spot Color and Technical Inks
When you import press-ready digital image files, Digimarc Verify analyzes spot color to simulate how different 
devices detect Digimarc digital watermarks. Digimarc Verify can analyze up to ten spot color channels per file in 
addition to the four process channels. You can choose additional channels, such as dielines and printer marks, to 
include in the preview. Select the boxes below Analyze and Preview to select or deselect all channels.

Tip
You don't need to include the dieline in the analysis. Dielines aren't usually enhanced, but including 
them in the preview can help you place regions accurately.
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Verify matches the ink separations to known colors. If it doesn't recognize an ink separation name, the application 
tries to substitute a known ink for the unknown one. See Color Matching in Verify for more information about how 
the application determines color matching.

To continue, click OK. To skip this file, click Cancel.

Note
There's a known issue in Verify v3.1.0 where spot colors that are in pattern elements are sometimes 
misinterpreted as process colors. This is not a problem with the artwork file but rather with how Verify
interprets the color within the pattern elements. See Troubleshooting for more information.

Select Regions
You use regions to designate the sides of a package and instruct Verify where to expect a digital 
watermark. Artwork that falls outside a designated region isn't evaluated. We recommend covering all areas of the 
artwork with regions to get the most accurate and complete evaluation of the digital watermark's expected 
performance for your use case(s).

When you move the cursor to an area of the artboard where no regions exist, it becomes the Marquee cursor ( 
), showing you can draw regions over the artwork. The cursor becomes a move cursor (   ) when positioned over 

a region. It becomes a resize cursor (   or   ) when positioned over a region's edges.
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Snap-to Guidelines
When you draw, resize, or move a region on artwork that already has one or more regions, blue guidelines show 
when the edges of the regions align. Red lines show where regions overlap. 

Note
You can't Run Verify on a project with overlapping regions.

To help you accurately place and size the regions, Verify "snaps" the region borders to the vertical or horizontal 
guidelines. To disable or enable the snap-to behavior, click the Magnet icon (   ) in the artboard toolbar. It's 
enabled by default.

Tip
To temporarily disable the snap-to behavior, press and hold <Ctrl> while sizing or moving a region.

Add a Region
To add a region:

1 Drag the Marquee cursor (   ) over the artwork to select different regions of the package to mark areas to 
verify. The minimum detectable size for a region is about 0.33 in2 (0.84 cm2) at 75 WPI and 0.18 in2 (0.46 
cm2) at 150 WPI. You can have up to ten regions across all images in the project.

• To delete a region, select it and press Delete.
• To move a region, drag and drop it as desired.
• To resize a region, drag and drop the edges.
• To change a region's name, you can:

- Right-click it and choose Rename Region to > <region name> (front, back, left, right, top, or
bottom).

- Right-click it and choose Edit Region Name. In the Rename Region dialog, type the desired
name and click OK.

Region names can contain only alphanumeric characters, spaces, parentheses, underscores, and 
hyphens.

2 Identify a region to represent the principal display panel. This is usually the region designated as the front 
of the package. Right-click the desired region and choose Make Region the Principal Display Panel. That 
region is marked with a star (   ).

Warning
If Mobile Phone or Robot is enabled in the Use Case Analysis section, one region must be 
marked as the principal display panel. If you don't choose one, one is chosen and marked for 
you when you run the verification.

3 To deselect regions, click an empty spot on the artboard.

4 To designate a region as flat or cylindrical, select the region and choose the desired Geometry (   ). The 
default is flat. See Artboard Toolbar Options and Working with Cylinders for more information.

5 Repeat these steps to add a region for each enhanced area of the artwork.
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Copy a Region
After you draw a region, you can copy it to another area of the artwork. The marquee cursor becomes a move 
cursor when positioned over a region.

To copy a region:

1 Right-click a region to select it and open the context menu.

2 Choose Copy Region. Verify pastes copy of the region to the artboard. It has a default name, such as 
Region 1.

Note
If you copy a region that's too large to fit on the artboard without overlapping an existing region, 
the copy fails.

3 Drag the new region to the desired location. You can also size it as needed.

Artboard Toolbar Options
Artwork that's enhanced with digital watermarks generally goes on the external product packaging. The 
packaging material, shape, and how it's oriented on store or warehouse shelves affect how the watermark is read.

Select the Substrate

The packaging material impacts how the enhancements perform. Digimarc Verify supports two substrates:

• Opaque
• Clear poly with ink

To set the substrate:

1 Select the region to work with. 

2 From the toolbar, click the Artwork substrate and opacity icon (   ).

3 Choose the desired substrate. The default is Opaque.

Select the Geometry

Product packages come in a variety of shapes and sizes. Some are flat, like a box, while others are cylindrical, like 
a can. Digimarc Verify supports two geometries:

• Flat: boxes and labels whose packaging is flat
• Cylinder: cans, tubs, bottles, or labels that wrap around a cylinder

For a cylindrical package, robot monitoring and mobile analyses require the camera-facing portion of the package 
to be identified as the principal display panel. To facilitate this, a white panel, the label wrap panel, is displayed 
over the artwork to show the approximate area of the package that will be visible from store or warehouse 
shelves. The size of the label wrap panel changes depending on the label wrap percentage. Drag the label wrap 
panel to cover the primary, camera-facing portion of the package. 

Note
The label wrap panel is shown only on the principal display panel.
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Example artwork for a flat package

Example artwork for a cylindrical package

Note
Some packages have artwork that includes both cylinders and flats. An example is a yogurt tub with 
one design that wraps around the tub and another that goes on the lid.
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To set the geometry:

1 Select the region to work with.

2 From the toolbar, click the Geometry icon (   ).

3 Choose the correct geometry. The default is Flat.

For information about working with cylindrical packages, see Working with Cylinders.

Select the Orientation

When working with artwork that wraps around a cylinder, how the artwork is oriented for reading could impact 
how the watermarks are detected.

Note
This property applies only for regions whose Geometry is Cylinder. The icon is disabled for Flat regions.

Verify supports two orientations:

• Wrap horizontal: the artwork wraps horizontally around the cylinder, like a soup can (   )
• Wrap vertical: the artwork wraps vertically around the cylinder, like a juice can (  )

To set the orientation:

1 Select the region to work with.

2 From the toolbar, click the Orientation icon (   ). 

3 Choose the correct orientation. The default is Wrap horizontal. 

For information about working with cylindrical packages, see Working with Cylinders.

Select the Label Wrap Percentage

When working with artwork that wraps around a cylinder, you can specify what portion of the package is covered 
by the region. This feature shows where watermark detection would be strongest when the product is scanned on 
a store shelf.

Note
This property applies only for regions whose Geometry is Cylinder. The icon is disabled for Flat regions.

Verify supports four label wrap values:

• 100% (default): the region completely covers the artwork
• 75%: the region covers three-quarters of the artwork
• 50%: the region covers half the artwork
• 25%: the region covers one quarter of the artwork
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To set the label wrap percentage:

1 Select the Principal Display Panel region, which is marked with a star (   ). The label wrap panel is placed 
on the principal display panel region.

Label wrap panel ( A ) on the principal display panel

2 From the toolbar, click the Label wrap percentage icon (   ).

3 Choose the value that represents the portion of the package that's covered by the region. In the example 
above, we used 100% (default).

4 Drag the label wrap panel to the area of the artwork that would best represent the camera-facing portion 
of the package.

Working with Cylinders
Most packaging has flat sides, such as a box of cereal or toothpaste. Some packages are cylindrical, such as a can 
of soup or frozen juice concentrate. The options on the artboard toolbar will help you select the right properties to 
get the best results from the digital watermark on your cylindrical packages.

Cylindrical packages present a challenge because when the product is sitting on store or warehouse shelves, the 
edges of the watermark could be farther away from the scanner or camera than the center is, causing some 
distortion. Digimarc Verify includes features to help determine the predicted success various scanners will have in 
reading the digital watermark on cylindrical packages.

The artboard toolbar is where you select options related to package shape.

• The Geometry icon (   ) enables you to choose between Flat and Cylinder.

• The Orientation icon (  ) enables you to choose whether the label is wrapped around the package 
vertically like a frozen juice container, or horizontally like a soup can.

• The Label Wrap Percentage icon (   ) enables you to specify how much of the package artwork is visible
from the front.
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Orientation

How the label is oriented on the package helps determine the size and shape of the label wrap panel. Consider 
these examples:

Geometry: Cylinder

Orientation: Wrap horizontal

Geometry: Cylinder

Orientation: Wrap vertical

Label Wrap Percentage

For a cylindrical package, robot monitoring and mobile analyses require the camera-facing portion of the package 
to be identified as the principal display panel. To facilitate this, a white panel, the label wrap panel, is displayed 
over the artwork to show the approximate area of the package that will be visible from store or warehouse 
shelves. The size of the label wrap panel changes depending on the label wrap percentage. Drag the label wrap 
panel to cover the primary, camera-facing portion of the package. 

Note
The label wrap panel is shown only on the principal display panel.

 This option is disabled for flat regions.
Digimarc Verify calculates the circumference of the cylinder based on the dimensions of the package artwork, the 
regions that cover it, and the Label Wrap Percentage you select. The size of the label wrap panel depends on 
these calculations.

The following examples show a label designed for a bottle of champagne. The Orientation is Wrap horizontal, but 
the same principles apply for regions whose orientation is Wrap vertical.
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Example 1

The first example shows a single region, Front, that completely covers the label artwork. The label wrap 
percentage is set to 100% because the artwork wraps completely around the bottle, whose circumference is 
about eight inches. Verify calculates the label wrap panel dimensions based on these measurements.

Example 2

The second example shows the Front region on the label for a larger bottle with a 16-inch circumference. The 
label has the same dimensions as in the first example, but it only wraps half-way around the bottle. The label wrap 
percentage is set to 50%. The label wrap panel is wider than in the first example because the bottle itself is wider, 
so the portion of the label that can be scanned from a store or warehouse shelf is wider.
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Multiple Cylindrical Regions
If you place multiple cylindrical regions on the artwork, each region has its own label wrap percentage value, 
but Verify places the label wrap panel only on the principal display panel region.

Example 3

The third example shows a label that wraps completely around the bottle. The artwork has two regions, Front and 
Back. Because the Front region of the label covers about three-quarters of the bottle's circumference, the label 
wrap percentage is set to 75%. The label wrap percentage for the Back region is set to 25%.

Selecting the Use Case Analysis
To get the most complete verification data, enable one or more use case analyses before you Run Verify. The 
analysis you select depends on the environment. This table summarizes the hardware and user behavior 
expectations for each type of analysis.

Note
Recycling Sortation is a Supplemental Feature and must be enabled before it becomes visible and 
selectable.
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Use Cases

Application Hardware Behavior

Retail Point-of-Sale with 
Fixed Barcode Scanners

• Illumination is red light (670
nm)

• Image sensor is monochrome
• Optical quality is low
• Scanner views one or two

sides only

• Package is swiped straight across the
scanner

• Users are trained or constrained to
swipe along package edges

Mobile Scanning with 
Consumer Apps

• Illumination is white light
(D50)

• Image sensor is RGB
• Optical quality is moderate
• Device field-of-view is a 4-

inch by 4-inch square

• User can target any location on
package

• As a rule, emphasis is placed on the
principal display panel or on the CTA
(call to action) if present

Manufacturing with 
Industrial Barcode 
Imaging

• Illumination is red light (620
nm)

• Image sensor is monochrome
• Optical quality is very high

(that is, distortion, noise, and
blur are negligible)

• Field of view is configurable

• Image capture is targeted to a
selected location or locations on the
package

• View is straight-on to the package

Shelf Analysis with Robot 
Monitoring

• Illumination is white light
(D50) with sufficient intensity
for detection

• Image sensor is RGB;
processing might be red-
channel only

• Optical quality is high with
sufficient resolution for
detection at working distance

• Robot captures an image of the
entire principal display panel of
the package

• View is straight-on to the package's
principal display panel

Recycling Sortation

• Illumination is red light
(670nm), Near-Infrared Light
(NIR) (730nm), and blue
(450nm) wavelengths

• Image sensor is monochrome
• Optical quality is high with

sufficient resolution for
detection at working distance

• Field of view is wide

• The entire package is scanned at
speed on a conveyer belt

• Package is often crumpled or dirty or
both
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 Understanding Results and Report Details

Digimarc Verify provides meaningful validation results through the user interface and enhancement reports in 
PDF.

Reports are saved in the folder C:\Users\yourname\Documents\Digimarc Corporation\Digimarc Desktop
Verify for Windows\Reports.

• Validation results provide information about the coverage area, score, and application ratings for
applicable analyses. For more information, see Viewing the Validation Results.

• Enhancement reports give you detailed information about the detection of a Digimarc digital watermark in
the artwork. To get an enhancement report, see Run the Enhancement Report. Each report contains one or
more sections. For more information, see Enhancement Report Sections.

Depending on the selected sections, the enhancement reports can include any or all of:

• Details about the project
• Validation results; the identified GTIN and Digimarc digital watermark coverage information
• A list of the ink separations found with Digimarc digital watermark
• A fidelity point check map
• A validation points map
• A channel color reference list that gives details about the color channels in the artwork, with target value

metrics to be used during press QC activities to confirm the document has been reproduced with
acceptable ink densities and colors.

Note
Ink separations with enhanced areas smaller than a Digimarc digital watermark tile might not be 
detected and reported in the Separations with Digimarc digital watermark section. Image previews 
shown in the Enhancement Report might not show spot colors as they would be displayed in graphics 
editors.

Viewing the Validation Results
When verification finishes, the Results panel shows whether the traditional product code and Digimarc digital 
watermark match. Examples of result messages:

• Success: Confirmed match of Digimarc Barcode and traditional product code.
• Fail: Inconsistent barcodes were found on the package.
• Fail: No Digimarc digital watermark found.
• Alert: A Digimarc digital watermark was found with no other product code.
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For artwork with a successful validation result, the Results panel gives information for the entire package and by 
region. Package and region information is limited for failed validation results. In some cases, such as Digimarc for 
Print, you can get a successful result without a traditional 1D barcode validation.

Results Panel (top) Results Panel (bottom)

Caution
If data validation fails for any reason, don't prepare plates or send the package for printing. Immediately 
contact your enhancement provider to correct the error.
If such a package is printed and placed on retail shelves, the wrong amount could be charged, or two 
different products could be charged in one transaction. This could disrupt supply chains, inventory 
tracking, and so on.
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The Verification Results section displays information about the enhancement.

• Barcode icon shows the value of the 1D traditional barcode on the package.

• Digimarc icon shows the digital watermark value that's been embedded in the artwork. If the watermark
has a product code, it must match the Barcode value for successful validation.

• WPI (waxels per inch) is an advanced artwork setting that is changed only in certain circumstances during
enhancement. WPI settings of 75 and 150 are supported; if the artwork is enhanced at any other setting,
Digimarc Verify displays an alert.

You can use the Package Information and Region Information as quality control measures for Digimarc digital 
watermark enhancement. Measurements are given for barcode scanners, mobile devices, and robot monitoring. 
This information is also included in the Enhancement Report.

Note
You must be signed into your account to see the Application Rating, Coverage Area, and Coverage 
score. These values aren't available for guest users.

• Rating shows the predicted performance of a Digimarc-enhanced package for the specified use case. This
assessment is based on the enhancement strength and coverage in key areas and is displayed on a scale
of 0–5, where 5 is best. See Application Ratings for more information.

• Coverage Area shows how much of the package is covered by Digimarc digital watermark in square
inches (in2) or centimeters (cm2).

• Coverage Score shows the overall quality of Digimarc digital watermark coverage, where 100 is best. The
coverage score is the average of all detected coverage in the selected region.

Click the rows in the table at the bottom of the window to view the different Maps.

Note
Validation results aren't saved in projects when you exit Verify, but they're kept in memory if you switch 
between projects. When you reopen a project, the Results and Maps panels are initially empty 
regardless of past verification activity. Run Verify again to get updated results.
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Failure Types
When one of the following warnings or alerts is displayed in the Results panel, work with the enhancement 
provider to resolve the problem. For more help troubleshooting problems, see Troubleshooting.

Multiple Digimarc Watermarks

The Validation Results show there are multiple Digimarc digital watermarks. Areas that contain mismatched digital 
watermark information appear red in the Validation Map.

Warning
Don't print the package. Contact your enhancement provider to correct the error. 

Digimarc Watermark Mismatches Traditional Product Code

The Validation Results show the Digimarc digital watermark doesn't match the traditional product code.

Warning
Don't print the package. Contact your enhancement provider to correct the error. 

No Traditional Product Code Found

The Validation Results show that no traditional product code was found on the package. Don't print the package 
until you have confirmed that it was designed without a traditional product code.

No Digimarc Watermark Found

The Validation Results show that no Digimarc digital watermark was found on the package. Don't print the 
package until you have confirmed that it was designed without a digital watermark.

No Traditional Product Code or Digimarc Watermark Found

The Validation Results show that neither a Digimarc digital watermark nor a traditional product code was found on 
the package. Don't print the package until you have confirmed that it was designed without a digital watermark or 
traditional product code.

Multiple Traditional Product Codes and Digimarc Watermarks Found

The Validation Results show that multiple digital watermarks and traditional product codes were found.

Warning
Don't print the package. Contact your enhancement provider to correct the error. 
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Run the Enhancement Report
After you Run Verify on the artwork project, Digimarc Verify offers four reports, each of which contains all or a 
subset of the report sections described below. For more information, see Understanding Results and Report 
Details.

To generate the enhancement report:

1 From the Project Toolbar, click the Create Enhancement Report icon (   ). The Report Options dialog 
opens.

Reports: Select the desired report from the drop-down list:
• Full Report: Includes all the sections listed below.
• Summary Only: Includes only the condensed summary section.
• Brief: Includes the condensed summary, barcode coverage, and

general information sections.
• Inspection: Includes the condensed summary, validation point,

fidelity point, target-value information (TVI), and general
information sections.

Sections: Shows the sections included in the report:

• Condensed summary
• Barcode coverage
• Validation point
• Coverage map
• Fidelity point
• Target-Value Information (TVI)
• General information

2 Select the desired report and section(s). To exclude a section from the report, disable it.

3 Click OK. Verify generates the report, and the Save Report dialog opens.

4 Specify the filename and location to save the PDF report file. Click Save. The PDF report opens with your 
default PDF viewer.

Application Ratings
Application Ratings show the predicted performance of a Digimarc-enhanced package or label for the specified 
use case. This assessment is based on the enhancement strength and coverage in key areas. The rating is on a 
five-star scale, where five stars is best. The table below summarizes the general performance expectations:

Star Rating Detection Details

★ Unlikely Less than minimal detection

★★ Minimal Not recommended for intended applications

★★★ Acceptable Recommended minimum for all intended applications

★★★★ Reliable Exceeds minimum recommended coverage

★★★★★ Optimized Preferred rating for all applications
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How Application Ratings Are Calculated
Application Ratings show the predicted performance of a Digimarc-enhanced package or label for a specified use-
case application (Retail Fixed Barcode Scanning, Mobile Consumer Engagement, Robot Monitoring, 
or Manufacturing). This assessment is based on the detected enhancement strength and coverage in key areas 
and is rated on a five-star scale, where five stars is best.

When calculating Application Ratings, several factors are considered:

• Application: Each application includes expectations for performance, hardware, and user behavior
• Placement: Where enhancement is detected on the package, determined by user-defined regions in

Digimarc Verify (for example, identifying the front, back, top, bottom, left, and right sides of a square
package or the front of a cylindrical package)

• Strength: The strength of the enhancement, determined by Fidelity Scores, shown as an array of colors in
the Coverage Detection Map

• Area: The total area of a region with detected enhancement

For more information about how Verify calculates the ratings for each use-case application, see Digimarc Verify 
Analysis.

Edge Zones
Edge zones are the four inches along each package edge, following the GS1 Edge rule, as specified in the GS1 
 General Specifications, section 6.3.3.3: “When possible, the barcode must not be closer than 8 mm (0.3 in.) or 
farther than 100 mm (4 in.) from the nearest edge of the package/container.” These areas are where a fixed 
barcode scanner is most likely to detect a watermark signal when a package moves across its sensor. Rectangular 
and cylindrical packages are handled differently.

• With a rectangular package, each side is measured 4 inches (100 mm) from the edge.
• With a cylindrical package, depending on the orientation of the wrap (whether the artwork is placed

horizontally or vertically on the package), the circumference of the cylinder and the region curvature are
considered.

Digimarc Verify Analysis for Applications 
This section describes how the application ratings are calculated for each use case analysis.

• Point of Sale
• Mobile Phone
• Manufacturing
• Robot Monitoring

Note
The application rating for recycling sortation isn't calculated because the enhanced packages are 
expected to be dirty, crumpled, and moved along a conveyor belt at high speeds.

Point of Sale

This section discusses how Digimarc Verify analyzes package artwork for the Point-of-Sale application.

Coverage Area
As Verify analyzes the package artwork, it converts the artwork to a grayscale map to determine where 
the artwork has been enhanced. This grayscale map is converted into a binary image, where enhanced areas with 
a Fidelity Score of over 50 are shown as white, and areas with a score less than 50 (including all unenhanced 
areas) are black.
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Front Back

Binary representation of a barcode scanner coverage detection map

To calculate the application rating:

1 For the Point-of-Sale application, Digimarc Verify groups the edge zones by region and calculates the 
Zone Score for each zone based on its Coverage Area and Fidelity Score using a lookup table (see 
the Coverage Area to Zone Score Lookup Table for Barcode Scanning).

2 The Zone Scores are then aggregated to a Region Score, which is weighted based on the size of the 
region in relation to the entire package (that is, a larger side is more likely to be scanned by a fixed 
barcode scanner than a smaller side).

3 The Region Scores are aggregated into a Package Score, which is the overall likelihood of detection (in 
percent).

4 The Package Score percentage is then translated into the Application Rating using a lookup table (see 
the Package Score to Application Rating Lookup Table.
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Sample Application Rating Calculation for Barcode Scanning

Region Edge Zone
Zone

Area (in2)
Zone
Score

Region
Score

Region
Weight

Package
Score

Application
Rating

Front

Top 6.9 0.9

0.83 1

0.71 3

Bottom 6.9 0.9

Left 6.9 0.9

Right 2.9 0.6

Back

Top 3.8 0.7

0.6 1
Bottom 3.8 0.7

Left 3.8 0.7

Right 1.2 0.3

Coverage Area to Zone Score 
Lookup Table for Barcode 

Scanning

Covered Area (in2) Zone Score

≥12.0 ≥1.0

≥6.0 ≥0.9

≥4.2 ≥0.8

≥3.1 ≥0.7

≥2.4 ≥0.6

≥1.8 ≥0.5

≥1.3 ≥0.4

≥0.9 ≥0.3

≥0.6 ≥0.2

≥0.3 ≥0.1

≥0.0 ≥0.0

Package Score to Application 
Rating Lookup Table for Barcode 

Scanning

Package Score Application Rating

>0.95 5

>0.75 4

>0.50 3

>0.25 2

>0.00 1

=0.00 0

Mobile Consumer Engagement

This section discusses how Digimarc Verify analyzes package artwork for the Mobile Phone application.

Coverage Area
For Mobile Consumer Engagement, Verify uses only one zone, the designated principal display panel of a 
package, to determine the Application Rating. Mobile devices are assumed to have a 4-inch field-of-view and 
users might point their device anywhere on the package. Verify analyzes the Coverage Detection Map for 
enhanced areas as a percent of the principal display panel. The application rating for the package is determined 
by the region score using a lookup table (see the Region Score to Application Rating Lookup Table for Mobile 
Engagement).
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Sample Application Rating Calculation for Mobile Consumer Engagement

Region Covered Area (in2)
Zone Score
(Percent covered)

Region
Score

Region
Weight

Package
Score

Application
Rating

Front <0 0.51 0.51 1 0.51 3

Region Score to Application 
Rating Lookup Table for Mobile 

Engagement

Region Score Application Rating

>0.95 5

>0.75 4

>0.50 3

>0.25 2

>0.00 1

=0.00 0

Manufacturing

For the Manufacturing application, all defined regions are assessed, with each region used as a single application 
zone. The Application Rating is based on the availability of suitable target areas and is assessed by the total 
covered area of the entire package. The coverage area is converted to the application rating using a lookup table 
(see the Coverage Area to Application Rating Lookup Table for Manufacturing).

Front Back

Sample Application Rating Calculation for Manufacturing

Region Zone Zone Area (in2) Application Rating

Front Entire side 9.7

Back Entire side 7.7

Sum of all side coverage 17.4 5
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Coverage Area to Application Rating 
Lookup Table for Manufacturing

Coverage Area (in2) Application Rating

>4.0 5

>2.0 4

>1.0 3

>0.25 2

>0.00 1

=0.00 0

Robot Monitoring

This section discusses how Digimarc Verify analyzes package artwork for the Robot application.

Coverage Area
For the Robot analysis, Verify uses only one zone, the designated principal display panel of a package, to 
determine the Application Rating. Verify determines the Zone score from the covered area using a lookup table 
(see the Coverage Area to Zone Score Lookup Table for Robot Monitoring). The Zone Score is translated into the 
Application Rating using a lookup table (see the Package Score to Application Rating Lookup Table).

Binary Coverage Detection Map for Robot Monitoring

Sample Application Rating Calculation for Robot Monitoring

Region Zone Area (in2) Zone Score Region Score Package Score Application Rating

Front 6.9 0.5 0.5 0.5 3
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Coverage Area to Zone Score 
Lookup Table for Robot 

Monitoring

Covered Area (in2) Zone Score

= 18 1.00

= 9 0.75

= 6 0.50

= 3 0.25

= 1 0.10

= 0 0.00

Zone Score to Application Rating 
Lookup Table for Robot 

Monitoring

Zone Score Application Rating

> 0.95 5

> 0.75 4

> 0.50 3

> 0.25 2

> 0.00 1

= 0.00 0

Enhancement Report Sections
The Enhancement Report is divided into sections:

• Condensed Summary
• Coverage Detection Map
• Barcode Coverage per Application
• Validation Points Map
• Fidelity Point Check
• Target-Value Information (TVI)
• General Information
• Consistency Map

Samples of the available enhancement reports follow. Your own enhancement reports will look similar.
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Condensed Summary
Available in all reports, the Condensed Summary displays a summary of the enhancement, including project 
information, application ratings, color separations, and previews of the artwork and the coverage detection map 
for each applicable use case analysis.

Note
Coverage detection maps are applicable only for Point of Sale (Barcode Scanner), Mobile, and 
Recycling analyses. 
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Barcode Coverage per Application
Available in the Full Report and Brief reports, the Barcode Coverage per Application summary shows how much 
of the package is covered by the Digimarc digital watermark, broken down by region for both barcode scanners 
and mobile devices. It includes the number of Digimarc digital watermarks in each region. Coverage scores show 
the overall quality of Digimarc digital watermark coverage, where 100 is best.

Note
This section of the enhancement report applies only for Point of Sale (Barcode Scanner), Mobile, and 
Recycling analyses. Manufacturing and Robot use case analyses don't provide data for this report.
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Coverage Detection Map
Available in the Full Report, the Coverage Detection Map section shows each region for each selected use case 
analysis. The detection maps show the coverage area, percentage, and coverage score for each region in the 
artwork for the relevant use case analyses. For each region, the coverage detection information is presented with 
a preview of the underlying artwork.

Note
This section of the enhancement report is applicable only for Point of Sale (Barcode Scanner), Mobile, 
and Recycling analyses. Manufacturing and Robot use case analyses don't provide useful data for this 
report.

Note
If you run the enhancement report on artwork that has a consistency problem, such as 
mismatched, missing, or extra codes, the Consistency Map section takes the place of this section in the 
Full Report.
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Validation Points Map
This section is available in the Full Report and Inspection reports.

Like for visible barcodes, the data in Digimarc digital watermark must be checked and validated. The Validation 
Points Map notes areas you scan with Digimarc Verify for iOS or Digimarc Verify for Android. Each Digimarc icon ( 

 ) represents an ink or separation carrying Digimarc digital watermark and has a corresponding validation point 
to scan. Multiple enhanced separations could be confirmed with the same validation point, indicated by a special 
icon (   ). The Validation Points Map shows where the print QC operator uses the phone's camera to check the 
print sample for quality.

Note
Some validation points might be too weak to detect with Digimarc Verify for iOS or Digimarc Verify for 
Android.

To download Digimarc Verify for iOS or Digimarc Verify for Android and find information about this process, visit 
 https://www.digimarc.com/verify.

https://www.digimarc.com/verify
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Fidelity Point Check
Available in the Full Report and Inspection report, the Fidelity Point Check shows the key audit locations to 
confirm the printed package has sufficient fidelity to retain the predicted detection measurements from the digital 
files. The Fidelity Points map shows where the print quality control (QC) operator scans the print sample (see 
Validating Your Scanner). The close-up image samples on the second page show where to scan the package to 
test the fidelity.

Note
If you scanned a print sample, the Fidelity Points are indicated by + marks on the coverage map. Fidelity 
Point locations, shown by a letter in the digital file, have a corresponding + mark in the scanned file, 
otherwise, the result is a failure. See Fidelity Point Failure for troubleshooting information.
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Target-Value Information (TVI)
This section is available in the Full Report and Inspection reports.
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General Information
Available in the Full Report, Brief, and Inspection reports, this section lists general information to keep in mind 
about the generated enhancement reports.

Consistency Map
If you run the enhancement report on artwork that has a consistency problem, such as mismatched, missing, or 
extra codes, the Consistency Map section takes the place of the Coverage Detection Map in the Full Report. This 
section shows where the Digimarc digital watermark is applied and whether the embedded product code is 
consistent with the traditional barcode:

• Blue areas show matching product codes
• Red areas show a mismatch
• Orange shows no codes are present
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 Manage Projects

Projects help you manage the enhanced artwork you verify. Each art file must be part of a project. We recommend 
you set the project metadata when you begin a verification project.

To create a project:

1 Click + New Project or select Projects > Create Project from the menu. Any open project is closed, and 
the artboard is cleared.

2 Set the project's metadata in the Project panel. Each field accepts alphanumeric characters, spaces, 
parentheses, underscores, and hyphens.

• Project Name - The name of the project.

• Account Name - The alphanumeric name for the account. This value might vary depending on your
use of Digimarc Verify.

• Project ID - The alphanumeric identifier for the project. This value might vary depending on your
use of Verify.

3 Add artwork. See Add Artwork to a Project.

To open a project:

1 Select Projects > Manage Projects from the menu. The Manage Projects dialog opens.

2 Double-click the desired project. It opens on the artboard. 

Note
Validation results aren't saved in projects when you exit Verify, but they're kept in memory if you 
switch between projects. When you reopen a project, the Results and Maps panels are initially 
empty regardless of past verification activity. Run Verify again to get updated results.

To delete one or more projects:

1 Select Projects > Manage Projects from the menu. The Manage Projects dialog opens.

2 Use the check boxes beside the listed projects to select projects for deletion.

3 Click Delete Checked Projects to delete only the selected projects.

4 Confirm you want to delete the project(s).

To search for a project:

1 Select Projects > Manage Projects from the menu. The Manage Projects dialog opens.

2 Enable the Filter per keyword and type option in the Search section.

3 Choose the field option on which to set the filter.

4 Type the keyword to filter by which the results. Results are narrowed as you type.
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 Manage Region Templates

When you want to apply the same regions to multiple artwork files or print samples, it might be helpful to save the 
regions to a template. Doing so enables you to apply the template to files you want to verify instead of having to 
redraw and name the regions for each file.

Note
Region templates are available only to signed-in users.

Create or Apply a Template
To create a template:

1 Draw the regions for the artwork and name them. See Select Regions for instructions.

2 Select File > Manage Region Templates from the menu. The Manage Region Templates dialog opens.

3 Click Save Current Regions as Template. The Region Template Name dialog opens.

4 Provide a unique Name for the template and click OK. Template names can be up to 24 characters long 
and contain only alphanumeric characters, spaces, parentheses, underscores, and hyphens. 

5 Click Done to close the dialog. The template is saved in folder C:
\Users\yourname\Documents\Digimarc Corporation\Digimarc Desktop Verify for 

Windows\Region Templates.

To apply a template to an artwork file or print sample:

1 Open another artwork file or scan another print sample whose layout matches that of the template.

2 Select File > Manage Region Templates from the menu. The Manage Region Templates dialog opens.

3 Select the desired template from the list.
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4 Click Apply Template to Current Artwork. You're warned that the operation replaces any existing regions 
you might have defined.

Note
The Apply Template to Current Artwork button is disabled for region templates that are too 
large to fit the artwork.

5 Click Done to close the dialog.

Export or Import Templates
You can export a saved template to a file in XML format and import a saved template file. This is useful when 
multiple operators are verifying similar artwork files or print samples, each of which contains a different Digimarc 
digital watermark.

To export a template:

1 Select File > Manage Region Templates from the menu. The Manage Region Templates dialog opens.

2 Select the desired template from the list.

3 Click Export Selected Template. The Select Folder dialog opens.

4 Navigate to the folder where you want to save the template and click Select Folder. The template is 
saved.

5 Click Done to close the dialog.

To import a template:

1 Select File > Manage Region Templates from the menu. The Manage Region Templates dialog opens.

2 Select the desired template from the list.

3 Click Import Template. The Browse for Exported Template dialog opens.

4 Navigate to the template file and click Open.

Note
Template names must be unique. If you have a template with the same name as the one in the 
file, rename or delete the existing template before importing the template file.

5 Click Done to close the dialog.

Rename or Delete Templates
To rename a template:

1 Select File > Manage Region Templates from the menu. The Manage Region Templates dialog opens.

2 Select the desired template from the list.

3 Click Rename Template. The Region Template Name dialog opens.

4 Provide a unique Name for the template and click OK. Template names can be up to 24 characters long 
and contain only alphanumeric characters, spaces, parentheses, underscores, and hyphens.

5 Click Done to close the dialog.
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To delete a template:

1 Select File > Manage Region Templates from the menu. The Manage Region Templates dialog opens.

2 Select the desired template from the list.

3 Click Delete Template. A dialog opens asking if you're sure you want to delete the template.

4 To delete it, click Yes; to cancel, click No.

Note
If you delete the template, it's removed from the list, but the file itself isn't deleted. Use the file 
explorer to find and delete the file, if desired.

5 Click Done to close the dialog.
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 Color Matching in Digimarc Verify

Digimarc Verify can import images in PSD, PDF, AI, BMP, PNG, or TIF formats. The images must be 300 DPI or 
greater and must contain standard process color channels or spot color channels or both. The color channels
must be 8 bits per channel.

Note
There's a known issue in Verify v3.1.0 where spot colors that are in pattern elements are sometimes 
misinterpreted as process colors. This is not a problem with the artwork file but rather with how Verify
interprets the color within the pattern elements. See Troubleshooting for more information.

Color Space
The color space of the artwork must be RGB or CMYK, but individual spot colors can be defined (for example, 
through a color picker or color library) in any of the color spaces mentioned here.

Storage
The color information for any channel can be stored in any of the following ways:

• XMP metadata
- Swatch
- Esko

• PSD display information
- RGB
- CMYK
- PANTONE® LAB
- LAB
- Adobe Color Book reference

• TIF channels

Note
CMYK images must contain the four standard process channels and can contain additional spot 
channels. RGB images must contain only the RGB channels; RGBA is not supported.
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Matching Sequence
After locating the color definition or description for each color channel in the image file, Verify tries to find a match 
for that color in its internal database. Preview colors for spot color channels are assigned based on the 
matching method used but don't affect the original artwork or analysis. Verify tries to match in the following order, 
so the reflectance values for that color can be used in accurately analyzing the enhancement for the targeted 
environment:

• Exact name match (such as “PANTONE 100 C”); the channel RGB preview color is determined by the
database entry

• Fuzzy name match (such as “PMS 100” or “P 100”); the channel RGB preview color is determined by the
database entry

• Color matching through one of two algorithms, given a comprehensive color definition or description:
- Weighted-XY
- Euclidean distance

• The channel RGB preview color is determined by the existing user-assigned channel preview color

The Digimarc internal database comprises 1951 colors, primarily coated colors. The algorithm can, however, find 
a match for an unknown color that's a close perceptual match for the original color.
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 Troubleshooting

If your enhancement report shows a low score or failure, consult this section for suggested remedies.

Fidelity Point Failure
The Enhancement Report includes a Fidelity Check Point Details page. This page contains details for each Fidelity 
Point, including which ink was modulated (and carries a Digimarc signal) and which ink might also be present in 
the area.

The Channel Color Reference page of the report provides details for each ink present in the image with target 
LAB values, densities, tone values, and reflectance at 670 nm. If your print inspection tool provides 
spectrophotometer data, a direct check of the R670 is the most targeted way to determine the cause of signal 
degradation.

Most common causes of fidelity point failure
You can diagnosed the following issues by inspecting a control strip. Inspect all inks that were enhanced and 
involved.

• An ink is too weak or too strong – perform a density check of that ink in a control strip.

• A color’s hue is incorrect – perform an LAB comparison of that ink in the control strip.

• Color Matching in Digimarc Verify – compare the 100% solid process ink to its mid-tone.

If the ink levels are acceptable, it might be necessary to look at the print under magnification or a loupe to 
diagnose.

• Inspect highlights and shadows for proper dot printing.

• Hybrid screening can compromise signal in highlights.

• LPI below 100 for spot colors can also cause fidelity point failure.

1D Barcode Mismatch
This error occurs when a non-existent 1D barcode is detected in the artwork, or a 1D barcode is present in the 
artwork but isn't detected. Inaccurate region placement can cause this problem. Try adjusting the regions and 
click Run Verify again.

Inconsistent Channel Polarity Is Detected
If a package has multiple enhancement techniques, Verify could interpret the enhancement as the inverse of what 
it expects to detect and give an alert about the channel polarity. This happens within a single channel only, usually 
because of color management, spot colors that have been merged to process colors, or a mix of positive and 
negative binary techniques. If this is the case, try enhancing using a multi-channel technique with the Magenta 
channel only, which ensures the channel polarity isn't inverted. This isn't expected to have a significant impact on 
the Barcode Scanner application.

Spot Color Elements Are Incorrectly Interpreted as Process Colors
There's a known issue in Verify v3.1.0 where spot colors that are in pattern elements are sometimes 
misinterpreted as process colors. This is not a problem with the artwork file but rather with how Verify interprets 
the color within the pattern elements. To work around this issue:

1 Open the file in Adobe Illustrator.

2 Select the pattern element that contains the spot color enhancement.
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•
•

3 From the menu, select Object > Expand Appearance.

4 From the menu, select Object > Expand.

5 Click OK on the Expand dialog.

6 Save the file.

7 Open the file in Verify again.

Digimarc Support
For help using Digimarc Verify, contact support.

 Digimarc Support website
 Send email to Digimarc Support

https://help.digimarc.com/
mailto:customer.care@digimarc.com
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Glossary

artboard

The main canvas where you draw regions on the packaging artwork. The artboard is on the Regions tab.

artwork

The elements of design and text that makeup packaging, labels, or other visual media, in which a Digimarc digital 
watermark is or will be included.

barcode

The generic term for an optically machine-readable pattern that encodes data in a way that is generally not 
recognizable to human observation.

color channel

Pixels storing intensity information for each component color in an image. Digital images commonly have plural 
color channels - one for each component color. For example, the CMYK color model used in a four-color process 
ink image has four channels: cyan, magenta, yellow, and black.

detect

The process of finding, geometrically aligning, and extracting a payload from a Digimarc digital watermark in an 
image.

Digimarc Barcode

The Digimarc digital watermark.

Digimarc digital watermark

A novel data carrier that encodes data in media in ways that are generally imperceptible to people, permitting the 
carrier to be repeated many times over the surface of the Enhanced media. It delivers unprecedented ease of use, 
reliability, and efficiency in identifying the media due to massive mathematical and graphical redundancy.

digital watermark

In this guide, digital watermark refers specifically to the Digimarc digital watermark.

edge zone

The four inches along each package edge as specified in the GS1  General Specifications, section 6.3.3.3: “When 
possible, the barcode must not be closer than 8 mm (0.3 in.) or farther than 100 mm (4 in.) from the nearest edge 
of the package/container.”

enhance

The process to integrate a Digimarc digital watermark into a label or package artwork, enabling it for scanning.

enhanced

Label or package artwork that has a Digimarc digital watermark integrated, enabling it for scanning.

enhancement

The result of creating and integrating a Digimarc digital watermark into product packaging and other artwork.
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enhancement strength

A variable intensity setting at which Digimarc watermarks are applied to an image, showing a degree to which 
artwork color or luminance values are changed by encoding. A higher, or stronger, enhancement strength will be 
more easily detected by machines and might be more visible to consumers.

fidelity block

A configurable image excerpt over which a fidelity score is measured.

fidelity point

The center of a fidelity block, with which a fidelity score for that block is associated.

fidelity score

A quantitative measure of scan performance at a point based on assessing detection of Digimarc digital 
watermark components at that point.

label wrap panel

A white panel with four round handles that's overlaid on cylindrical principal display panel regions. It marks the 
camera-facing portion of a package on a store or warehouse shelf.

point of sale (POS)

The time and place where a retail transaction is completed. Also called Point of Purchase (POP).

principal display panel

The side of a package that faces outward on a store or warehouse shelf.

process color

A color comprised of percentages of cyan, magenta, yellow, and black (CMYK) typically printed with halftone 
printing plates.

reflectance

The proportion of light striking a surface that is reflected off it. Contrast can be derived by comparing the 
reflectance of two colors.

regions

Areas you draw on the artboard to tell Verify where to expect digital watermarks.

robustness

The ability of Digimarc digital watermarks to be decoded correctly even if degraded.

spot color

A color generated by an ink (pure or mixed) that is printed using a single run. This is different from a process color, 
which is produced by overlaying multiple impressions using different colors.

substrate

The base material to be printed on.
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supplemental feature

Some features, such as the Recycling Sortation use case analysis, are unlocked with a special code. If you're 
interested in supplemental features, contact Digimarc.

synchronization signal

The reference signal that facilitates detection and geometric registration of a Digimarc digital watermark. Also 
called a "grid."

tile

The fundamental unit of Digimarc digital watermarks, formed by combining an encoded message and 
synchronization signal in a 2-dimensional area, which is repeated in whole or in part across artwork or a label.

validation

The process of checking that the data carried in a Digimarc digital watermark is both accurate and consistent.

validation point

The location in enhanced artwork that is designated for quality evaluation. The data validation process checks the 
GTIN carried in Digimarc digital watermarks, within an inspection area centered at this point, to determine whether 
the GTIN is correct and consistent with the GTIN in other areas and any 1D barcode in the artwork.

verification

The activity of measuring fidelity according to a standard and performing data validation.

waxel

A spatial cell in a tile to which a component of a message and synchronization signal may be mapped. Waxel is 
short for "watermarking element." See "tile."

WPI

The resolution of a Digimarc digital watermark represented as waxels per inch.
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